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Creating Audio and Data Discs
This chapter contains the procedures you must perform to record (or burn) music 
and data files to recordable CD and DVD discs. It also includes information about 
labeling your discs using the LightScribe labeling technology included on select 
models.

For information about recording video files to DVDs, see “Creating Video Discs 
and Movies” on page 17.

Your PC includes one or more CD, DVD, or combination optical drives capable of 
recording. Additionally, your PC may include the following software programs for 
recording to CDs or DVDs:

• iTunes
• Windows Media Player
• Sonic MyDVD Plus (select models only)
• Sonic DigitalMedia Plus
• Windows XP
These programs include features that enable you to copy, archive, and manage 
music and data files and then record the files to CDs or DVDs. You can also use 
iTunes or Windows Media Player to download and copy music files to a portable 
device or memory card.

IMPORTANT: HP supports the lawful use of technology and does not endorse 
or encourage the use of our products for purposes other than those permitted by 
copyright law.

NOTE: Burn is an industry term used to describe the recording of information onto 
a DVD or CD. Optical recording uses a laser beam to place information onto the 
disc, thus the term burning.
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Erasing Rewritable Discs Before 
Recording
Previously recorded files on CD-RW, DVD-RW, or DVD+RW discs must be erased 
before recording new files. CD-R, DVD-R, and DVD+R discs cannot be erased.

To erase a rewritable disc in Sonic DigitalMedia Plus:

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click Tools and then Erase Disc.

3 Insert the rewritable disc you want to erase.
4 Click the Quick Erase or Full Erase option, and then Erase Disc.

Working with Audio CDs
Sonic DigitalMedia Plus enables you to create audio CDs that play in your car or 
home CD player, and on PCs. You can create two main types of music CDs:

• Uncompressed — Typical CD format like you would purchase on a 
commercial CD. This type of CD will hold 10 to 20 songs depending on 
their length. 
Uncompressed files can be burned on CD-Rs (which play in most home and 
car stereos, DVD players, and computers) or CD-RWs (which play only in some 
stereos, DVD players, and computers).
The procedure for creating this type of CD is described in “Creating audio 
CDs” on page 4.

• Compressed — Files are burned to a disc using a compressed file format 
(MP3, WMA, or M4A). The smaller file format enables you to fit approximately 
ten times as many songs onto the disc (depending on length and format). 
Compressed files can be burned to CD-Rs, CD-RWs, DVDs, DVD-RWs, or 
DVD+RWs (select models only). Compressed files can only be played on 
computers, CD players, or DVD players that support the file format you use to 
create the disc (MP3 is most commonly supported). For file format compatibility, 
check the documentation for the device where you intend to play the disc. You 
may hear a slight loss of sound quality using compressed audio files.
The procedure for creating this type of CD is described in “Creating jukebox 
discs” on page 4.
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For more compatibility information, see “Disc Features and Compatibility Table” on 
page 13.

Both Sonic programs create closed-session music CDs, which means you must 
record all music files on one CD in one recording session. Music files can be 
recorded repeatedly on a rewritable CD-RW disc, but all previously recorded 
files must be erased first. CD-R discs cannot be erased.

Verifying audio disc recorded without errors

When copying or burning audio files to CD, it is recommended that you use Sonic 
DigitalMedia Plus because it includes a feature that confirms that your disc has been 
created without errors.

This data verification feature is enabled by default.

To check the status of the write verification feature in DigitalMedia Plus:

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click Tools, and then Options.

3 In the Options window, click Copy.
4 Ensure the Verify copied data discs option is checked.
5 Click OK.

Audio CD tips

When recording music files, it is important to note that:

• To play your music CD in a home or car stereo, it needs to be recorded as a 
music CD in CD audio (CDA) format, not as a data CD.

• As you add music files in the recording session, DigitalMedia Plus calculates 
and displays the amount of recording time available to record additional 
music files.

• You can’t record song titles unless you make an exact copy of a music CD in 
your collection.

IMPORTANT: HP supports the lawful use of technology and does not endorse 
or encourage the use of our products for purposes other than those permitted by 
copyright law.
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• If your recording fails, manually select a slower recording speed, if available, 
each time you make a recording. Refer to the Help menu in your selected 
software program for more information about selecting a slower recording 
speed.

• If you try to record more than a standard CD can hold, a message displays 
warning you that all the tracks may not fit on your disc.

Creating audio CDs

To create uncompressed audio CDs using Sonic DigitalMedia Plus:

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click the Audio tab and then Audio CD.
3 Do one or more of the following:

• Click Add Music and navigate to music stored on your PC.
• In the Quick Find panel, click Scan to automatically search your PC 

for songs.
• Insert a CD and add songs from it.

4 Select the songs you want to record, and then click Add.
5 Click the Burn icon when you have added all the audio files to your 

music CD project.
6 When prompted, insert a blank CD-R or CD-RW disc. If you want to 

play your music CD in your home or car stereo, use a CD-R disc. 
CD-RW discs may not play in some stereos.

7 Click OK.
You can get detailed online help by clicking the Help menu and then 
selecting Help.

Creating jukebox discs

To create compressed (jukebox) music CDs or DVDs using Sonic DigitalMedia Plus: 

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click the Audio tab, and then Jukebox CD/DVD.
3 Do one or more of the following:

• Click Add Music and navigate to music stored on your PC.
• In the Quick Find panel, click Scan to automatically search your PC 

for songs.
• Insert a CD and add songs from it.

IMPORTANT: HP supports the lawful use of technology and does not endorse 
or encourage the use of our products for purposes other than those permitted by 
copyright law.
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4 Select the songs you want to record, and then click Add.
5 Click the Burn icon when you have added all the audio files to your 

music CD project.
6 When prompted, insert a blank disc. 

DVD discs can store significantly more music files than a CD. Jukebox discs can 
only be played on computers, CD players, or DVD players that support the file 
format you use to create the disc (MP3 is most commonly supported). 
For file format compatibility, check the documentation for the device where you 
intend to play the disc.

7 Click OK.
You can get detailed online help by clicking the Help menu, and then 
selecting Help.

Working with Data DVDs and CDs
Unlike audio CDs and jukebox DVDs, data DVDs and CDs can be recorded in 
multiple sessions.

Verifying data disc recorded without errors

When copying or burning data files to DVD or CD, it is recommended that you use 
Sonic DigitalMedia Plus because it includes a feature that confirms that your disc 
has been created without errors.

This data verification feature is enabled by default.

To check the status of the write verification feature in DigitalMedia Plus:

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click Tools and then Options.

3 In the Options window, click Data.
4 Ensure the Verify data written to the disc after burning box is checked.
5 Click OK.

NOTE: DigitalMedia Plus scans for all audio files, even the sounds from your 
operating system. If you don’t want to display some of these sounds, you can select 
the Options icon (wrench), and then select Audio. Select Hide Audio Files 
Shorter Than (in seconds), and then type the number of seconds, and click OK.
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Data disc tips

When storing data files on a disc, it is important to note that:

• You can add new data files to a CD-R, DVD+R, or DVD-R in a later 
recording session, until the disc is full. With DVD+R or DVD-R discs, 
insert your partially recorded DVD, click the Wrench icon to display 
the Options window, click Data, select the first Write-Once DVD 
Compatibility option, and then click OK.

• When you record files that have the same name as previously recorded files, 
Sonic DigitalMedia Plus updates the file and the previous version is overwritten.

• Sonic DigitalMedia Plus allows you to change the names of files you want to 
record and the files that were previously recorded.

• As you select data files to record to your disc, Sonic DigitalMedia Plus 
calculates and displays the amount of recording space used on your disc.

• If your recording fails, manually select a slower recording speed, if available, 
each time you make a recording. Refer to the Help menu in your selected 
software program for more information about selecting a slower recording 
speed.

Creating data discs

To create data CDs or DVDs using Sonic DigitalMedia Plus: 

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click the Data tab, and then click Data Disc.
3 Do one or more of the following:

• Click Add Data and navigate to files stored on your PC.
• In the Quick Scan panel, select a type of file to search for, and then click 

Scan to automatically search your PC for the selected file type.
• Insert a CD or DVD that contains the file you want to add.

4 Select the files you want to record, and then click Add.
5 To name your disc, click Volume Label, and then type a name over it. Sonic 

DigitalMedia Plus assigns a name based on the recording date if you do not 
type a name.

6 Click the Burn icon when you have added all the files to your data 
project.

7 When prompted, insert a blank or appendable disc. 
DVD discs can store significantly more files than a CD.

8 Click OK.
6 Creating Data, Audio, and Video Discs on your PC



You can get detailed online help by clicking the Help menu and then 
selecting Help.

Copying a DVD or CD
Sonic DigitalMedia Plus enables you to make copies of an existing music or data 
disc. You can configure Sonic DigitalMedia Plus to verify that:

• Data files have been copied without errors by performing the procedure 
described in “Verifying data disc recorded without errors” on page 5.

• Music files have been copied without errors by performing the procedure 
described in “Verifying audio disc recorded without errors” on page 3.

To make a copy of an existing music or data disc using Sonic DigitalMedia Plus: 

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click the Copy tab, and then Disc Copy.
3 Insert the CD or DVD you want to copy.
4 Insert a blank DVD or CD into the drive.
5 Click the Copy icon.
6 Click Done when the recording is complete.

NOTE: An appendable disc can have additional files added to it, if there is disc 
space available. Recorded audio CDs are closed-session discs that are not 
appendable.

NOTE: You can rename your files in the file selection window by selecting and 
typing over the current name. This does not affect the original files on your hard 
disk drive.

NOTE: DVD discs can store significantly more files than a CD.

IMPORTANT: HP supports the lawful use of technology and does not endorse or 
encourage the use of our products for purposes other than those permitted by 
copyright law.
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Archiving Files on a CD or DVD
To make an archive file copy of files stored on your PC using 
Sonic DigitalMedia Plus: 

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click the Data tab and then Easy Archive.
3 Select the path to the files that you want to archive (or click Browse to 

navigate to them).
4 Select the type of files you want to add to the archive, or select All Files in the 

Selected Path.
5 Place a check mark in the Only Archive Files Changed Since box, and select a 

date to limit the scan to files that have been changed since that date.
6 Click Save, enter a name for your archive, and then click OK.
7 Click the Burn icon.
8 When prompted, insert a recordable disc and then click OK.

If the files do not fit on one disc, you are prompted for additional 
discs.

9 Click Done when recording is complete.
For additional information about saving archives on your hard disc drive, or 
scheduling automatic archives, see the online help.

Working with Image Files
The Sonic recording programs can convert all the files from a CD or DVD and 
convert them into a single .iso file, or a series of .gi files (none exceeding 2 GB) 
known as an image file. You can use the image file to reproduce the original disc. 
Image files are typically used when you need to make multiple copies of the 
same disc.

NOTE: Your DVD Writer or CD Writer drive will not copy commercially available 
DVD movies. Most commercial DVDs are encoded to prevent unauthorized 
duplication.
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Creating an image file

To make an image file using Sonic DigitalMedia Plus: 

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click Copy, select .iso or .gi, and then click Save Image.
3 Insert the CD or DVD from which you want to make an image file.
4 Click Browse to select the location where the image file will be created.
5 Click the Save Image icon to create the image file.

Burning from an image file

To burn a CD or DVD from an image file using Sonic DigitalMedia Plus: 

1 Open the DigitalMedia Plus program by clicking Start, All Programs, 
Sonic, and then DigitalMedia Home.

2 Click Copy and then Burn Image.
3 Click Browse to select the image file.
4 Insert a recordable CD or DVD into the drive.
5 Click the Burn Image icon.
6 Click Done when recording is complete.

Disc Labeling with LightScribe
LightScribe (select models only) is a direct disc labeling technology providing you a 
simple way to burn precise, silk screen-quality labels. It combines the CD or DVD 
drive of your PC with specially coated discs (sold separately) and enhanced disc-
labeling software.

A LightScribe-enabled CD or DVD disc drive uses the optical laser in the drive to 
burn a label onto a thin dye coating on the label side of the disc. There is no ink to 
smear or paper to curl, and there are no adhesives to loosen.

LightScribe media is identified by the LightScribe logo on the retail packaging and 
on the inner hub area of the disc itself. Your PC may come ready to work with many 
versions of LightScribe media (select models only); however, as new media versions 
are introduced you will need to update the driver software for your LightScribe-
enabled CD or DVD drive. Get driver updates from the HP Support Web site: 
http://www.hp.com/support

NOTE: LightScribe creates a grayscale image similar to a black and white 
photograph.
Creating Audio and Data Discs 9
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LightScribe requirements

Burning a label with LightScribe requires three things:

• LightScribe-enabled DVD drive (select models only).
• Labeling software that supports LightScribe.
• LightScribe discs (sold separately).

Burning a LightScribe label with 
Sonic Express Labeler

1 Click Start, All Programs, Sonic, and then click Express Labeler.

2 In the Step 1: Select Project area, make sure that Disc Label is selected.
3 In the Step 2: Edit area:

a Click Disc Titles to display the Edit Disc Title window. Enter text for the title 
and subtitle, and then click OK.

b Click Tracks to display the Edit Tracks window. Click New to display the 
Track window. Enter text to identify the first track or file (you can optionally 
enter artist and date, or length), and then click OK.

c Repeat the previous step for each track or file on the disc.
d Click the left or right arrows next to Layout and Background to select 

design elements for the disc. The selections you make are previewed in the 
disc window.

4 When you are satisfied with the appearance of your label, insert the 
LightScribe media disc (label side down) into the disc drive tray, and then 
click Print.

5 From the Disc Label menu, select LightScribe 12cm disc.
6 Click OK to begin burning the label.
The estimated time to complete the label displays, along with a progress bar to 
show you the time remaining. You can continue to work on your PC while 
LightScribe is burning the label.

NOTE: You can open Express Labeler from within DigitalMedia Plus by clicking 
Tools, and then Label Disc.

NOTE: LightScribe creates a grayscale (monochrome) image similar to a 
black-and-white photograph.
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Burning a LightScribe label after burning 
with iTunes

iTunes works with Sonic Express Labeler to allow you to burn labels on a LightScribe 
audio CD. The playlist you create in iTunes to burn a disc is automatically imported 
into Express Labeler so that this information is available for you to use on your 
LightScribe label. To use Express Labeler from iTunes, the music tracks in the playlist 
you are using must fit on a single CD.

1 Click Start, All Programs, iTunes, and then click iTunes again.
2 Burn an audio CD with iTunes. When the burning process is complete, click 

Yes on the Create LightScribe Label window.
3 In the Step 1: Select Project area, make sure that Disc Label is selected. 
4 In the Step 2: Edit area:

a Click Disc Titles to display the Edit Disc Title window. Enter text for the title 
and subtitle, and then click OK.

b Click Tracks to display the Edit Tracks window. Click New to display the 
Track window. Enter text to identify the first track or file (you can optionally 
enter artist and date, or length), and then click OK.

c Repeat the previous step for each track or file on the disc.
d Click the left or right arrows next to Layout and Background to select 

design elements for the disc. The selections you make are previewed in the 
disc window.

5 When you are satisfied with the appearance of your label, insert the 
LightScribe media disc (label side down) into the disc drive tray, and then 
click Print.

6 From the Disc Label menu, select LightScribe 12cm disc.
7 Click OK to begin burning the label.
The estimated time to complete the label displays, along with a progress bar to 
show you the time remaining. You can continue to work on your PC while 
LightScribe is burning the label.

NOTE: LightScribe creates a grayscale image similar to a black-and-white 
photograph.
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Using adhesive disc labels

Compatibility Information
An important feature of a DVD Writer/CD Writer drive is its high level of 
compatibility with other optical drives and CD and DVD players:

• The CDs that you create play in most home and car stereos and in most 
computer DVD-ROM and CD-ROM drives.

• The DVDs that you create are compatible with some DVD video players and 
with most computer DVD-ROM drives.

• CD-R discs are more compatible with home and car stereos than CD-RW 
discs are.

Your DVD Writer/CD Writer drive is able to read from and record to almost every 
type of optical disc. Writing speed rates for the DVD Writer/CD Writer drive are 
fast, allowing quick recording times.

WARNING: When labeling your CDs and DVDs, do not use 
sticky labels. They can cause the disc to play erratically. 
Instead, write on the disc with a felt-tip pen to label it.

Or, you can create a LightScribe label for your disc if you have 
a LightScribe optical drive and you use LightScribe media 
discs. Refer to “Disc Labeling with LightScribe” on page 9.

NOTE: CD-R discs are more compatible with home and car stereos than CD-RW 
discs.
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Disc Features and Compatibility Table

Disc File type
Can be 

recorded onto Plays in PC
Plays in home 
or car stereo

Plays in home 
DVD player

CD-ROM Data No Yes No No
Music No Yes Yes Varies by model

CD-R Data Yes Yes No No
Music Yes Yes Varies by model Varies by model

CD-RW Data Yes Yes No No
Music Yes Yes Varies by model Varies by model

DVD-ROM Data No Yes No No
DVD movie No Yes No Yes

DVD+R 
and DVD-R

Data Yes Yes No No
DVD movie Yes Yes No Varies by model

Double-
Layer 
DVD+R/
DVD-R

Data Yes Varies by model No Varies by model
DVD movie Yes Varies by model No Varies by model

DVD+RW 
and
DVD-RW

Data Yes Yes No No
DVD movie Yes Yes No Varies by model

VCD DVD movie No Yes No Varies by model

NOTE: Some PCs come with the Double-Layer DVD Writer. It supports single-layer and double-layer DVD media. 
Double-Layer technology gives you greater capacity and allows you to store up to 8 GB* of data on double-layer 
DVD+R or DVD-R media.
Double-Layer is a new technology. Double-Layer media compatibility will vary widely with some home DVD 
players and DVD-ROM drives.
*1 GB is defined as 1 billion bytes. 1 GB = 1 billion bytes when referring to hard disk drive capacity. Actual 
formatted capacity is less.
For the latest disc compatibility information for your PC, go to the HP Support Web site at: 
http://www.hp.com/support

NOTE: Double-Layer DVD technology is supported by select models only.

NOTE: The Sonic recording programs support the double-layer technology.
Creating Audio and Data Discs 13
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Optical Drive Quick Reference Table

Optical drive can: CD-ROM CD-RW DVD-ROM
DVD+RW/+R
DVD-RW/–R

Double-
Layer DVD

Combo 
CD-RW/

DVD

Read CDs, CD-Rs, 
and CD-RWs

Yes Yes Yes Yes Yes Yes

Read DVDs No No Yes Yes Yes Yes

Read data on a CD Yes Yes Yes Yes Yes Yes

Play music Yes Yes Yes Yes Yes Yes

Record data or music 
to disc for storage or 
backup

No Yes No Yes Yes Yes

View DVD movies No No Yes Yes Yes Yes

Record DVD movies No No No Yes Yes No

Play games Yes Yes Yes Yes Yes Yes
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Software Quick Reference Table
Your PC includes a number of software programs that: 

• Record and play CDs.
• Record data CDs.
• Import and edit video files.
• Record video CDs and DVDs.
• Organize digital media files.
The following table describes the functionality specific to each of these programs. Use it to determine which 
program to use to perform a task.

Note that some programs listed may not be included with your model, and that this is not a complete list of all 
included software.

To open any of these programs, click Start on the taskbar, choose All Programs, select the program folder (for 
example, Sonic ), and then click the program name to open the software.

With this program: You can:

InterVideo WinDVD 
Player

• Play DVD movies and video CDs (VCDs).

iTunes • Play music CDs, MP3s, and other audio files.
• Record music files.
• Record a copy of an existing music or data CD to use on the PC.
• Organize digital files into a library for recording or listening.

muvee autoProducer 
(select models only)

• Add your own style to your movies with music, pictures, titles, scene transitions, 
and captions.

• Edit your home movies.

RealPlayer • Play music CDs, MP3s, and other audio files.
• Play DVD movies. (RealPlayer can play DVDs only if another DVD player 

program, such as InterVideo WinDVD, is installed.)
• Play video CDs.
• Record music files.
• Organize digital files into a library for recording or listening.
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Sonic DigitalMedia Plus • Record data and music files.
• Record a copy of an existing music or data CD to use on the PC.
• Create customized music CDs from CDs in your collection, or from .wav, .mp3, 

or .wma files. These CDs can be played in your home or car stereo.
• Copy and share data files.
• Create archive CDs or DVDs from files on your PC.
• Capture (copy) video files.
• Has setting for verification that the disc has been created without errors.

Sonic MyDVD Plus 
(select models only)

• Record data and movie files.
• Record a copy of an existing DVD to use on the PC.
• Copy and share video files.
• Capture (copy) video files.

Windows Movie 
Maker 2.0

• Import audio, video, and other media files from a videotape, an audiotape, a 
Web camera, or a television broadcast.

• Record audio and video files to create a video project that becomes a Windows 
Media source file with a .wmv extension.

• Edit and preview files.
• Send a movie in an e-mail or upload it to a Web server.
• Add music files (.mp3).
• Import audio files such as .mp3, .asf, or .wma; video files such as .wmv, .asf, 

.avi, or .mpg; or image files such as .jpg or .gif.
• Create .avi and .wmv (Windows Media Video) files.

NOTE: You may have a software update CD included with your PC. You may need to install this CD before using 
the DVD Writer/CD Writer drive. To do this, follow the installation instructions that came with the CD.

With this program: You can:
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Creating Video Discs and Movies
Your PC may include the following movie-making programs, depending on 
your model:

• Sonic MyDVD
• Sonic DigitalMedia Plus (which includes MyDVD)
• Windows Movie Maker
• muvee autoProducer (select models only)
These programs all capture, edit, and manage your home video files, while 
allowing you to add your own personal touch to your home movies. They come 
installed on your PC and can be started by clicking Start and then All Programs 
on your desktop.

Before You Begin Capturing Video
You can capture (copy) video files to your hard disk drive by using the Sonic 
MyDVD program. Among the devices supported by Sonic MyDVD are analog video 
devices, digital camcorders, and Web cameras. Use your composite or S-video 
inputs (input connectors vary by model) to capture video from a VCR or an analog 
video camera.

To capture video files, you need to:

1 Connect your video source device according to the device’s instructions.
2 Turn your device on and set it to playback mode.
3 Make sure Sonic MyDVD can detect your digital or analog device.
4 If your PC has multiple video devices connected, they all appear on the Capture 

screen. You must select the video source you would like to use.

IMPORTANT: HP supports the lawful use of technology and does not endorse or 
encourage the use of our products for purposes other than those permitted by 
copyright law.

NOTE: You may need to turn your digital video device off and on again for the 
program to detect it.
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For more information, click Start, All Programs, Sonic, and then DigitalMedia 
Home. When the program displays, click Help and then Sonic MyDVD Help.

Sonic MyDVD Video Projects
A Sonic MyDVD video project is a way to group, organize, store, play, and burn 
related video and still digital files. For example, if you went on a family vacation, 
you might have digital still and video images, and prints from a film camera. You 
can transfer all these images onto your PC and organize them into a project. (A 
scanner is required to transfer printed photos and is not included.)

Projects can remain on your PC for playback and as an archive, and they can be 
burned to a DVD or VCD disc.

Sonic MyDVD enables you to create video projects using the following interfaces:

• Standard program interface (described beginning in “Creating a Video Project” 
on page 18).

• Direct-to-Disc Wizards (described beginning in “Creating a Video Project with 
Direct-to-Disc Wizard” on page 23).

Note that the Direct-to-Disc Wizards do not include the editing features that are 
available from the standard interface. You can edit a project created with a wizard 
before burning it to a disc as described in:

• “Editing the style of a video project” on page 21.
• “Editing movie files” on page 21.

Creating a Video Project
To create a video project:

1 Click Start, choose All Programs, Sonic, and then DigitalMedia Home.
2 Click the Video tab to display the Video Guide.
3 Click Create Project, and then DVD or VCD depending on the type of 

project you want to create.
A project named Untitled DVD-Video or Untitled VCD-Video is created and 
displayed in the MyDVD project window.

4 Click File and then Save to change the name of your project from Untitled to a 
more descriptive name. After renaming your project, click Save.

Continue your project by performing the procedure described in one or more of the 
following sections:

• “Adding files to a video project” on page 19.
• “Capturing video to a video project” on page 19.
• “Adding slide shows to a video project” on page 20.
• “Adding submenus to a video project” on page 20.
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Adding files to a video project

You can add files to your DVD or VCD video project from:

• An existing DVD or VCD.
• Video files already stored on your PC.
• Video capture from a digital video camera (as described in the next section).
To add files from a DVD, VCD, or from your hard disk drive:

1 Click File, Open, and then select a video project that you created as 
described in “Creating a Video Project” on page 18.

2 Click Add Files.
3 Navigate to the folder that contains the video files you want to add or to the 

media drive that contains the DVD or VCD.
4 Select the files you want to add, and then click Open. The files are added to 

the current project and displayed in the project window.

Capturing video to a video project

You can capture live video or still images by connecting a Web camera or digital 
video camera to your PC’s front-panel USB connector (select models only). The video 
capture is added to your video project and stored in a file on your hard disk drive.

To add a video capture to a video project:

1 Click File, Open, and then select a video project that you created as 
described in “Creating a Video Project” on page 18.

2 Connect your digital camera to the USB port.
3 Click Capture Video to display the Capture screen.

Sonic MyDVD displays the name of the capture device (your camera), the 
default Capture Type (audio and video), and the default Quality Setting (High 
Quality).

4 Click Record Settings to edit any of these default settings.
5 Optionally, set a Capture Length, chapter points, or scene detection. 

Click the corresponding Help icon to display the online help for each of 
these features. 

6 Click one of the following:
• Grab Frame — The image currently displayed in the Capture window is 

stored as a picture file (JPG, BMP, GIF, TIF, or PNG format).
• Start Capture — Starts a video capture (.mpg format). Click Stop 

Capture to manually stop the capture if you did not set a capture length 
(step 5).

7 In the Save As dialog box, name the captured file and select the file format and 
the folder where you want to save it. Click Save.

8 Click OK to return to the project window.
The file is stored on your hard disk drive and added to the current project.
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Adding slide shows to a video project

You can create a slide show (a series of still images displayed automatically) by 
adding existing still photos to your project or by capturing them with a connected 
digital video source.

To add a slide show to a video project:

1 Click File, Open, and then select a video project that you created as 
described in “Creating a Video Project” on page 18.

2 Do one or more of the following:
• Add existing picture files as described in “Adding files to a video project” 

on page 19.
• Capture still images as described in “Capturing video to a video project” 

on page 19.
3 Click Options to set the slide duration, or to add a background audio 

track. Online help is available for these features by clicking the 
Help icon.

4 Click OK.

Adding submenus to a video project

Each project element (video file, still picture file, and slide show) that you add to a 
video project is represented in the main project window.

Each menu displays six items before a new menu is automatically created 
and linked to the previous menu by a Next button.

You can manually add submenus to a project and use them to organize 
topics associated with the theme of your project. For example, if the project is your 
child’s soccer game, the video files of the game could be the main menu elements, 
and you could insert a submenu that contains interviews with your son and his 
teammates.

To add a submenu to a video project:

1 Click File, Open, and then select a video project that you created as 
described in “Creating a Video Project” on page 18.

2 Click New Sub-Menu. A submenu called Untitled Menu 1 is added to the 
first menu that has less than six project elements.

3 Click the submenu name (Untitled Menu 1), and type an appropriate name 
for the menu (for example, Interviews using the previous example).

4 Double-click the new submenu, and do one or more of the following:
• Add existing picture files as described in “Adding files to a video project” 

on page 19.
• Capture still images as described in “Capturing video to a video project” 

on page 19.
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Editing the style of a video project

You can change the style of a number of elements within your video project. The 
elements include:

• Background color and graphics on the menus and submenus.
• Button styles.
• Background music.
• Text format (font, color, and size).
• Import custom styles.
To edit the look of a video project:

1 Click File, Open, and then select a video project that you created as 
described in “Creating a Video Project” on page 18.

2 Click Edit Style.
3 In the Edit Style dialog box, change any of the previously mentioned 

elements, and then click Apply To All Menus or Apply 
To This Menu.

Editing movie files

After you capture or import video files, you can edit them using Sonic MyDVD to:

• Add additional files.
• Add background music.
• Search for specific scenes.
• Delete scenes.
• Add transition effects between scenes.
• Superimpose colors, themes, and effects over video scenes.
• Superimpose text effects over video scenes.

To edit your video files:

1 If your project is already open, click Edit Movie and skip to step 4.
2 Click Start, All Programs, Sonic, and then DigitalMedia Home.
3 Click the Video tab, and then File, New Project or the Open 

Existing Project.
4 If you have already captured video for this project, they appear along the 

bottom as a storyboard. If you have video files on your hard disk drive you 
would like to add to this project, click Add Files.
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5 Click one of the four tabs (Fades and dissolves, Filters, Text, or Themes 
and backgrounds) next to the preview screen.

6 Drag and drop any of the effects over scenes (or between them for transitions) 
in the storyboard.

7 Click OK to save the edits.
For more information about any of the editing features, click Help and then Sonic 
MyDVD Help from within the Edit window.

Burning a video project to disc

After you are satisfied with the contents and style of your video project, you can 
burn it to a DVD or VCD disc as follows:

1 Click File, Open, and then select a video project that you created as 
described in “Creating a Video Project” on page 18.

2 Save the file if you have made changes.
3 In the Quality fields, set the recording quality and the DVD or VCD type:

• The quality settings range from HQ (the highest quality, but uses the most 
disc space), to EP (lowest quality, but you can fit more files).
As you select different quality settings, the disc space remaining indicator 
displays how much blank space there is on the disc for this mode.

• The DVD formats include 2xDVD (8.5GB) (Double-Layer), DVD (4.7GB) 
(the default setting), DVD-RAM (2.6GB), and DVD (1.4BGB). 
Some of these formats may not be supported by your model of PC.

4 Insert the selected type of disc into the appropriate drive tray, close it, 
and click Burn.

For detailed information about DVD and VCD recording quality and 
time, see:

• “Video Quality and Disc Size” on page 24.
• “DVD Recording Time” on page 25.
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Creating a Video Project with 
Direct-to-Disc Wizard
Sonic MyDVD includes Direct-to-Disc Wizards that guide you through the steps you 
must complete to create a DVD or VCD video project. A video project is a way to 
group, organize, store, play, and burn related video and still digital files.

1 Connect your digital camcorder or Web camera to your PC.
2 Click Start, choose All Programs, Sonic, and then DigitalMedia Home.
3 Click the Video tab and then Direct-to-Disc.
4 Click DVD or VCD depending on the type of project you want to create. The 

Direct-to-VCD or Direct-to-DVD Wizard displays.
5 Click Edit Style, and edit any of the following elements:

• Background color and graphics on the menus and submenus
• Button styles
• Background music
• Text format (font, color, and size)
• Custom styles
Alternately, you can click No Menus if you do not want to be able to select 
from multiple files in the project.

6 Type a name for your project in the project name field.
7 Click one of the following:

• Record to DVD (or Record to VCD if you are creating a VCD 
project) — Select the device, number of copies, and write speed.

• Record to hard disk — The video capture is stored by default in the 
My DVDs folder. Click Location if you want to select a different folder.

8 Click Next. The Capture screen displays.
Make sure the output from your digital camcorder appears in the Preview 
window. If it does not, double-check your connections and make sure your 
camera is in playback mode.

9 Click Record Settings to edit any of the default settings.
10 Optionally, set a capture length, chapter points, or scene detection. Click 

the corresponding Help icon to display the online help for each of these 
features. 

11 Click one of the following:
• Grab Frame — The image currently displayed in the Capture window is 

stored as a picture file (JPG, BMP, GIF, TIF, or PNG format).
• Start Capture — Starts a video capture (.mpg format). Click Stop 

Capturing to manually stop the capture if you did not set a capture length 
(step 10).

12 A confirmation message displays stating the disc or file was created 
successfully. Click OK.
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Note that the Direct-to-Disc Wizards do not include the editing features that are 
available from the standard interface. You can edit a project created with a wizard 
before burning it to a disc as described in:

• “Editing the style of a video project” on page 21.
• “Editing movie files” on page 21.

Video Quality and Disc Size
Sonic MyDVD includes four DVD video quality (bit-rate) settings, and a Fit-to-DVD 
option that can be applied to a video project or to individual movie files. The DVD 
quality settings are: 

• HQ (High Quality) — Best audio and video quality, but requires the most 
disc space per second of video. Good choice for video files that contain 
high-speed action (for example, motor sports). 

• SP (Standard Play) — Good audio and video quality with most video 
sources. 

• LP (Long Play) — Fits approximately twice as much video onto a DVD as 
HQ. Not recommended when the original video is low-quality or noisy. 

• EP (Extended Play) — Fits the most video onto a DVD, but video quality is 
low. Not recommended unless the original video is very good quality. 

• Fit-to-DVD — As you add more content to the project, MyDVD reduces the 
project quality automatically to fit the selected disc size. Fit-to-DVD is the default 
setting for new projects. 

NOTE: VCDs have a fixed bit-rate which delivers one quality level. You can fit 
approximately one hour of video on a VCD (the recording time is reduced if you use 
animated menu buttons or backgrounds). 

NOTE: You can record the same file on a disc at each different speed to compare 
the results.
24 Creating Data, Audio, and Video Discs on your PC



DVD Recording Time
The following table lists the approximate DVD-Video recording time for different disc sizes at different video quality 
settings (your DVD recorder may not support all these disc sizes).

• The video quality depends on your PC’s speed and graphics processing abilities. Some PCs may be unable to 
capture video at the HQ setting. 

• These are estimated recording times. The maximum duration is reduced if you use animated menu buttons or 
backgrounds. 

• To choose the audio format, see “Changing the audio format (DVDs only)” in the online help. 
• Your version of MyDVD may not support Dolby Digital audio. See the online Help for details.

Video Quality Audio Format

Estimated Time per Disc Size

8.5 GB 4.7 GB 2.6 GB 1.4 GB

HQ Dolby Digital 130 min. 70 min. 40 min. 20 min.

PCM 110 min. 60 min. 30 min. 15 min.

SP Dolby Digital 210 min. 120 min. 65 min. 35 min.

PCM 160 min. 95 min. 50 min. 25 min.

LP Dolby Digital 310 min. 180 min. 100 min. 50 min.

PCM 215 min. 125 min. 65 min. 35 min.

EP Dolby Digital 415 min. 240 min. 130 min. 70 min.

PCM 265 min. 150 min. 85 min. 45 min.
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Creating Movies Using 
muvee autoProducer
Creating personalized and professional-looking video movies is simple 
with muvee autoProducer (select models only). 

Basic Steps to Make a Movie
The basic steps to produce a movie with muvee autoProducer are:

1 Capture digital video: Capture live or recorded video to your hard disk 
drive directly from a compatible digital video camcorder.

2 Add videos and pictures: Select video and picture files from your PC 
folders. You can easily add videos and still images to your movie production.
You can use these video and still image file types in your movie project:

File extension File type

.dv Digital Video

.avi Audio Video Interleaved 

.mpeg-1 Motion Picture Experts Group

.mpeg-2 For DVD video playback

.wmv Windows Movie Video

.jpg, .jpeg Joint Photographic Experts Group, still image

.gif Graphics Interchange Format, still image

.bmp Bitmap, still image
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3 Add music: Select music files on your PC to add to your movie soundtrack. 
You can use these music file types in your movie project: 

4 Select a style: Apply a movie style editing template for different effects and 
picture transitions in your movie.

5 Add captions: Personalize your movie with opening titles and closing credits.
6 Make the movie: Automatically analyze the videos, pictures, music, movie 

style, and captions you added to your movie and save your movie to your PC 
hard disk drive, CD, or DVD.

7 Burn to disc: You can burn a video to DVD, VCD, or SVCD. 
The following sections contain detailed instructions. 

Locating the muvee autoProducer

You can access muvee autoProducer as follows: 

Click Start on the desktop taskbar and select All Programs, muvee 
Technologies, muvee autoProducer, and then muvee autoProducer to 
open muvee autoProducer. This version of muvee has more features, such as video 
capture and disc recording. 

See “Using muvee autoProducer” on page 29. 

File extension File type

.mp3 MPEG Layer 3

.wav Windows audio 

.wma Windows Media audio

NOTE: To view help files, press the F1 function key on the keyboard.
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Using muvee autoProducer

Getting started

To open muvee autoProducer: 

1 Click Start on the taskbar.
2 Select All Programs, muvee Technologies, muvee autoProducer, and then muvee 
autoProducer to open muvee autoProducer.

3 Open a project by selecting, from the File menu, either New Project or Open Project.
4 Select one of the button options: 

NOTE: You can also open muvee autoProducer from within Digital Media Plus. Select the Video tab and 
then muvee autoProducer. 

Button Allows you to See

Get video 
from 
camera

Open the muvee Video Capture window to 
capture (copy) live video or recorded video.

“Capturing video from a DV 
camcorder” on page 31.

Add 
Video 

Open the Add Video window to add existing 
video files to your project. 

“Adding videos” on page 32.

Add 
Pictures 

Open the Add Pictures window to add existing 
still image files to your project. 

“Adding pictures” on page 33.

Add 
Music 

Open the Add Music files window to add existing 
music files to your project. 

“Adding music” on page 33.

Select Style Open the Select Style window to select an editing 
template for your movie. 

“Selecting the style” on page 34.

Change 
Settings

Open the muvee Settings window to adjust audio 
and video production settings for your movie. 

“Changing the settings” on 
page 34.
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Title/
Credits

Open the muvee Title and Credits window to type 
in an opening title and closing credits for your 
movie.

“Adding an opening title and 
closing credits” on page 35.

make muvee Open the Make muvee window to automatically 
create and preview the movie.

“Making the movie” on page 36.

Save 
muvee

Open the Save muvee window to save the 
finished movie on your PC hard disk drive in 
WMV or MPEG formats.

“Saving the movie project” on 
page 36.

Burn to 
Disc

Open the muvee Burner window to record the 
finished movie in DVD, VCD, or SVCD formats.

“Recording the movie project to 
disc” on page 37.

Button Allows you to See
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Capturing video from a DV camcorder

You can capture (copy) digital video files to your hard disk drive by using muvee 
autoProducer either: 

• Live (known as camera mode) using a compatible DV camcorder. See 
“Capturing live video from a DV camcorder” on page 31.

Or

• Recorded (known as VCR mode) using a recorded tape in your DV 
camcorder. See “Capturing recorded video from a DV camcorder” on 
page 31.

Captured video files are automatically added to your movie project. To remove the 
file from your movie project, select the video file in the list of Captured Video Files, 
and then click the trash can icon.

When capturing video, it is important to be aware of the amount of free space 
available on your PC hard disk drive. Capturing video can use a large amount of 
disk space. The amount of free disk space displays on the Capture Video window in 
muvee autoProducer while you are capturing video.

Capturing live video from a DV camcorder
Capturing live video in camera mode allows you to create a video file without even 
having a tape in the camcorder.

To capture (copy) live video to your hard disk drive using muvee autoProducer:

1 Connect your DV camcorder to the FireWire (IEEE 1394) port on your PC. 
2 Turn on the camcorder and set to VCR mode. Refer to the instructions in the 

manufacturer’s documentation.
3 Click the Get Video from Camera button. 
4 Click the Start Capture button to begin capturing the live image 

directly to your hard disk drive.
5 Click the Stop Capture button to stop capturing.
6 Click Capture Folder to specify a folder for the captured video file.
7 Click Filename to specify a file name for the captured video file.
8 Click the Done button to automatically add captured video files to your 

movie project. 

Capturing recorded video from a DV camcorder
For best results with muvee autoProducer, capture only video footage that you are 
most interested in using in your movie project.

To capture camcorder (copy) recorded video to your hard disk drive:

1 Connect your DV camcorder to the FireWire (IEEE 1394) port on your PC.
2 Turn on the camcorder and set to VCR mode. Refer to the instructions in the 

manufacturer’s documentation.
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3 Click the Get Video from Camera button. 
4 Click the Play button on the screen to begin viewing the video.
5 Click Start Capture when you see the start of the video footage you want to 

use in your movie project.
6 Click Stop Capture to stop capturing.
7 Repeat steps 5 and 6 to capture additional sections of video footage.
8 Click Capture Folder to specify a folder for the captured video file.
9 Click Filename to specify a file name for the captured video file.
10 Click the Done button to automatically add captured video files to your 

movie project. 

Adding videos

To add video files to your movie production:

1 Select the Add video button in the video/pictures area. The Add 
Picture window opens. 

2 Browse the folders. 
3 Select existing video files on your hard disk drive, if desired for your movie:

• Add up to three video files. 
• Select multiple video files by pressing and holding Ctrl on your keyboard 

while selecting the files.
4 Adjust the order of the video files by selecting and then dragging and dropping 

the file. Select the clip, and click the trash can icon to remove a video clip 
from the production. 

5 You can mark specific scenes in a video clip to include or leave out of your final 
movie, with the magicMoments feature in muvee autoProducer.
To select video scenes with magicMoments:

a Select a video file in the Select Video/Pictures window, and then 
click the magicMoments button. The magicMoments window 
opens. 

b Click the Play button to start viewing the video. 
c Use the magicMoment controls to mark video scenes to include and 

exclude:

• Click and hold down the green thumbs-up button to mark scenes that 
must be included in the movie.

• Click and hold down the red thumbs-down button to mark scenes 
that must be left out of the movie.
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• Click or hold down the gray thumb button to undo one second of a 
selected scene. Shift and click to undo scenes that were marked with the 
thumbs-up or thumbs-down buttons.

• Click or hold down the arrow buttons to navigate backward and 
forward through the video footage.

Video footage left unmarked is still analyzed when you make the movie and 
may be included in the final version of the movie.

For best results with the production of your movie:
• Keep each magicMoment to less than 10 seconds. 
• Keep the total duration of magicMoments to less than 50 percent of the 

duration of your movie. It is recommended to select only a few scenes.
d Click OK when you finish marking scenes. The window closes. Note that 

the video clip is marked on the lower left side. 

Adding pictures

To add still image files to your movie production:

1 Select the Add Pictures button in the Video/Pictures area. The Add 
Picture window opens. 

2 Browse the folders, as required. 
3 Select existing still image files on your hard disk drive, if desired for your 

movie:
• Add up to 50 .jpg, gif, or .bmp picture files. 
• Select multiple picture files by pressing and holding Ctrl on your keyboard 

while selecting the files.
4 Adjust the order of the picture files by selecting and then dragging and 

dropping the picture file. Select the picture, and click the trash can icon to 
remove a picture from the production. 

5 Select the Rotate Image Clockwise button to rotate still images. 

Adding music

To add music files to your movie production soundtrack:

1 Select the Add Music button in the music area. The Add Music 
window opens. 

2 Browse the folders, as required. 
3 Select existing music files on your hard disk drive, if desired for your movie:

• Add up to three .mp3, .wav, or .wma files. 
• Select multiple music files by pressing and holding Ctrl on your keyboard 

while selecting the files.
4 Adjust the order of the music files by selecting and then dragging and dropping 

the file. Select the music, and click the trash can icon to remove a music clip 
from the production. 
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Selecting the style

The muvee autoProducer program comes with a set of style templates for setting the 
pace, scene transition effects, and caption fonts. The style you use also affects how 
muvee autoProducer combines the video, picture, and music files in your movie 
project to produce the final movie.

For example, using the Cinema style results in a movie that is moderately paced, 
color enhanced, and uses a wide-screen format.

To select a style, just click on a style from the list. A sample of the style displays in 
the preview window.

Changing the settings

You can adjust audio and video production settings for your movie.

1 Select the Change Settings button. The muvee Settings window 
opens. 

2 Select the Duration tab to set the length of your video production and 
preferences. Click one of the following duration settings:
• Fit to music. The produced version may re-use or drop some video and 

pictures. 
• Best fit for videos and pictures. The produced version may repeat or 

trim music. 
• User Defined. Select the duration in minutes and seconds:

• If the duration of your music is longer than the duration of video and 
pictures, place a check in the Allow video and pictures to repeat 
check box to repeat video clips and pictures for the full duration of your 
music files.

• If the total duration of your video and picture files is longer than the 
duration of your music, place a check in the Allow Music to repeat 
check box to repeat music for the duration of the video clips.

3 Select the Video tab to set the video and still image preferences. Click one of 
the following settings:
• Style default. Use the selected style to sequence still images and video 

clips. 
• Keep shots in sequence. Use the sequence of still images and video 

clips in the Add Video/Pictures window. 
• Shuffle shots. Move the slider bar to determine the frequency of 

sequencing still images and video clips. 
• Place a check in the Interleave pictures check box to blend pictures with 

video at intervals.
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4 Select the Audio tab to set the sound preferences. Click one of the following 
settings:
• Use all music. Place a check in the check box to use the sequence of 

sound files in the Add Music window.
• smartJoin™ multiple music files. Place a check in the check box to 

automatically remove silence between music tracks. 
• Normalize music. Place a check in the check box to automatically adjust 

audio playback volume to the same level. 
• Move the slider bar to adjust the Sound mix level of the music and 

original soundtrack. 
5 Click OK when you are finished adjusting the settings for your movie project. 

Or
Click Cancel to not change any settings.

Adding an opening title and closing credits 

You can personalize your movie project by adding an opening title and closing 
credits.

1 Click the Title/Credits button. The muvee Title and Credits window 
opens. 

2 Click the Title tab:
a Select a Title effect from the drop-down window.
b Type the text you want to appear at the start of your movie in the Enter your 

title here box.
c Click the Use font button to select the font, style, size, color, and effects 

from the Font window.
d Select a background image for the title. 

3  Click the Credits tab.
a Select a Credits effect from the drop-down window.
b Type the text you want to appear at the end of your movie in the Enter your 

credits here box.
c Click on the Use font button to select the font, style, size, color, and effects 

from the Font window.
d Select a background image for the ending credits. 

4 Click Apply.
5 Click OK to close the muvee Title and Credits window.
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Making the movie

After you have added at least one video or picture file to your movie project, you 
can have muvee autoProducer make the movie.

The muvee autoProducer program makes a movie by combining the video, picture, 
and music files you have selected, along with the style of movie, and puts together 
all of these pieces into a professional-looking movie with just a few steps.

To make a movie:

1 Click the make muvee button. Click OK as required. 
2 After making a movie you can preview the movie in the muvee autoProducer 

Preview window. Use the controls in the Preview window to play, pause, and 
stop the movie preview:
• Each time you make a change to a movie project, you need to click the 

make muvee button again to add that change to your movie.
• You can revise and preview the movie as often as you want to experiment 

with different styles and the content of the movie.

Saving the movie project

Once you are satisfied with the look of your movie project, you are ready to save it.

You can save the movie to a file on your hard disk drive or create a VCD or 
DVD disc.

1 Click the Save muvee button. The Save muvee window opens. 
2 Choose the movie file type to save to your hard disk drive:

• Computer Playback
• E-mail
• DV (camcorder)
• DVD
• VCD (video CD)
• SVCD
• Web Streaming
Change the video and audio settings of the movie file type as required 
(advanced users only).
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3 Click the Save button. 
4 Enter a name for the output movie. Select a folder on your hard disk drive, as 

required. The movie saves. 
• You can watch the preview as it saves. 

5 Click the Save button. 
6 Click Yes to preview the output file in Windows Media Player. 

Recording the movie project to disc

To create a DVD, VCD, or SVCD disc:

1 Click the Burn to Disc button. The muvee Burner window opens. 
2 Type the disc title.
3 Select the video(s) to burn to the disc:

• Select the order of the chapters.
• Add or delete videos, as required. 

4 Select the disc menu theme from the drop-down list. 
5 Select the disc. 
6 Select the type of video disc to create: DVD, VCD, or SVCD. 
7 Click Burn Now to begin burning your movie to disc.
8 Click OK when the recording is complete. Close the muvee Burner window.

Upgrading muvee autoProducer
You can purchase an upgraded version of muvee autoProducer with the following 
enhancements:

• mpeg-4, DivX, .mov (Quicktime™) video format support.
• Tiff audio format support.
• You can include up to 75 video and audio clips in your movie production.
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